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3rd Party Licenses

This software is based in part on the work of the Independent JPEG Group
Copyright (C)2009-2013 D. R. Commander. All Rights Reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

- Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

- Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

- Neither the name of the libjpeg-turbo Project nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS", AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Safety

Place the Kodak Scan Station 700 Series on a level work surface capable of supporting 9.97 kg (22 Ibs.)

When placing the Scan Station, make sure that the electrical power outlet is located within 1.52 metres (5 feet) of the Scan
Station and is easily accessible.

When relocating the Scan Station, it is recommended that two people lift the Scan Station and use safe lifting techniques.

Do not install the Scan Station in a location subject to dust, humidity or steam. This may cause electrical shock or a fire. Only
use the Scan Station indoors in a dry location.

When disconnecting equipment from the electric socket, be sure to grasp the plug, not the cord.
Never disassemble or modify the AC adapter, as this is dangerous.

Do not use an AC adapter other than the one provided with the Scan Station. Do not use the AC adapter provided with the
Scan Station for any other products.

Be sure the power cord is securely plugged into the wall outlet. Failure to do so may cause electrical shock or fire.
Do not damage, knot, cut or modify the power cord or use a damaged power cord. This may cause electrical shock or fire.

The Scan Station requires a dedicated and properly grounded power outlet. Do not use an extension cord or power strip with
the Scan Station.

Leave sufficient space around the power outlet so it can be easily unplugged in case of an emergency.

Do not use the Scan Station if it becomes inordinately hot, has a strange odor, emits smoke, or makes unfamiliar noises.
Immediately stop the Scan Station and disconnect the power cord from the power outlet. Contact Kodak Alaris Service.

Do not disassemble, service or modify the Scan Station except as explained in the Administrator's Guide.

Do not move the Scan Station with the power cord and interface cable attached. This may cause damage to the cord/cable.
Remove the power cord from the wall outlet before moving or relocating the Scan Station.

Follow the Kodak recommended cleaning procedures. Do not use air, liquid or gas spray cleaners. These cleaners displace
dust, dirt and debris to other locations within the scanner, which may cause the Scan Station to malfunction.

Material Safety Data Sheets (MSDS) for chemical products are available on the Kodak website at:
www.kodakalaris.com/go/msds. When accessing the MSDSs from the website, you will be required to provide the catalog
number of the consumable you want the Material Safety Data Sheet for.

Environmental information

The Kodak Scan Station 700 Series is designed to meet worldwide environmental requirements.

Guidelines are available for the disposal of consumable items that are replaced during maintenance or service; follow local
regulations or contact Kodak locally for more information.

The Kodak Scan Station 700 Series is Energy Star compliant and shipped from the factory with the default time set to 15
minutes.

For recycling or reuse information, contact your local authorities, or in the USA, visit:
www.kodakalaris.com/go/scannerrecycling.

The product packaging is recyclable.
Parts are designed for reuse or recycling.

European Union
Ej This symbol indicates that when the last user wishes to discard this product, it must be sent to appropriate facilities

for recovery and recycling. Please contact your local Kodak representative or refer to:
www.kodakalaris.com/go/recycle for additional information on the collection and recovery programs available for

L this product.

Please consult www.kodakalaris.com/go/REACH for information about the presence of substances included on the candidate
list according to article 59(1) of Regulation (EC) No. 1907/2006 (REACH).

Battery Information

This product contains a Lithium button cell battery. This battery can only be removed or replaced by a qualified Service
Engineer.

CAUTION:
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Taiwan:

B4 I Rias » A% (A]3% ) Scan Station 730EX / Scan Station 710 /
Equipment name Type designation (Type) Scan Station 700 / Scan Station 720EX
SRR S NI 5173
H < Unit Restricted substances and their chemical symbols
Ay & 4 + % 42 FREE | SR FRL
Lead Mercury Cadmium Hexavalent Polybrominated | Polybrominated
(Pb) (Hg) (Cd) chromium biphenyls diphenyl ethers
(cr*d) (PBB) (PBDE)
ACHEBD 25 - O O O O O
AC Adapter
USBEE - O O O O O
USB Cable
N7 &R - O O O O O
Memory Module
BiRHR — O O O O O
Power Cable
B /o AR O O O O O O
Input / Output Trays
fE1R O O O O O O
Touchscreen
AErE O O O O O O
Microphone
BE O O O O O O
Plastic Covers
HR{E R O O O O O O
Paper Sensors
R O O O O O O
Rollers
£ O O O O O O
Motors
im0 O O O O O O
Ports

FAL N0l wt % 2 CARD00Iwt %" R4 FFLF A ZEALNF A ZEARE o
Note 1 : “Exceeding 0.1 wt %” and “exceeding 0.01 wt %" indicate that the percentage content of the restricted substance exceeds the reference
percentage value of presence condition.

§%2. 07 B R LT A FRARNE AN FEARE -

Note 2 : “(” indicates that the percentage content of the restricted substance does not exceed the percentage of reference value of presence.

BE3 N B AR

Note 3 : The “~” indicates that the restricted substance corresponds to the exemption.
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Acoustic emission

Maschinenlarminformationsverordnung — 3, GSGV
Der arbeitsplatzbezogene Emissionswert betragt <70 db(A).

[Machine Noise Information Ordinance — 3, GSGV
The operator-position noise emission value is <70 dB(A).]

phase est de 230 V.

EMC statements

United States: This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to Part
15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of these measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the dealer or an experienced radio/TV technician for additional suggestions.

Any changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to
operate the equipment. Where shielded interface cables have been provided with the product or specified additional
components or accessories elsewhere defined to be used with the installation of the product, they must be used in order to
ensure compliance with FCC regulation.

Korea: As this equipment has obtained EMC registration for household use, it can be used in an area including residential
areas.

0 717l AYFLE YA MARESTF ¢ 72N RAAY A= F =
DE AN AE2E £ A&UL,

Japan: This is a Class A product based on the standard of the Voluntary Control Council for interference by information
Technology Equipment (VCCI). If this is used near a radio or television receiver in a domestic environment, it may cause radio
interference. Install and use the equipment according to the instruction manual.

CDEEG. BRLBELEESERETETEMGHES (VCC ) OR#
L§o<7sxsﬁﬁﬁmﬁﬁf¢ COEERG. REBSTEAT L&
AL LTOETH, COEBLAS A BT LEDa R EMITHEELT
EESNhZE. BEEELESI=RCT_EAnBYET.

ERIREHBREI“ € > CEL (OVERY PR(VE L T T & 0,
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Chapter 1 Overview

What’s in the box

The Kodak Scan Station 710/730EX is designed as a walk-up device
that requires no host PC or application software. It works with and uses
an existing network and network shared services to communicate with
other network devices or destinations. The Scan Station 710/730EX is a
capture solution that allows you to quickly send your documents via
email, network, networked printers, USB drives, fax, FTP, SharePoint
and Kofax Front Office Server with a simple touch.

This Administrator’s Guide provides the information you need to setup
and administer the Kodak Scan Station 710 and Kodak Scan Station
730EX. These models will be referred to as Kodak Scan Station 700
Series. Any differences between these models will be noted.

Before you begin open the box and check the contents:

e Kodak Scan Station 710/730EX
* Power cord bundle

* \Welcome Folio which includes:

- Installation CD

- Registration sheets

- User Reference Guide, English

- Maintenance Reference Guide, English
- Installation Guide

- Country Contact sheet

- Miscellaneous flyers
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Setting up the Scan
Station

Carefully unpack the Scan Station 710/730EX and place it on a clean,
dry and level surface. Refer to the Installation Guide or the “Rear view”
illustration later in this chapter for port locations.

1.

Select the appropriate AC power cord. Plug the power adapter into
the power port on the Scan Station. Plug one end of the power cord
into the power adapter and plug the other end into the wall outlet.

Plug one end of the 10/100/1000 Base T network cable (customer
provided) into the Ethernet port of the Scan Station and plug the
other end of the network cable into the network port.

If you have a Scan Station 730EX with serial number earlier than
52190000, connect a phone line to the RJ-11 modem port.

When the Scan Station is properly connected, press the power
button and wait a few moments for the Scan Station to start up and
display the application.

Proceed to Chapter 2, Pre-installation Checklist to review and
gather the necessary configuration information before installing the
Kodak Scan Station 700 Series - Scanner Administration application
and creating configurations.

After reviewing the Pre-installation Checklist, you can setup your
configurations. See Chapters 3-9 for more information.
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Setting up
configurations

You must configure the Scan Station using the Kodak Scan Station 700
Series - Scanner Administration application before you can use it. The
application allows you to configure and manage your Scan Stations.

A Scan Station configuration consists of setting the following groups of
options: Device Settings, Scan Settings, Index Templates, Destinations,
Groups, and Jobs. These options are accessible via the Configuration

tab on the Scan Station 700 Series - Scanner Administration application
using the Edit menu.

* Device Settings — consists of the following configuration items. See
“Chapter 4 Configure Device Settings” on page 31 for more
information.

Device Options: used to configure the Scan Station (e.g., display
language, date, time, etc.).

Email Server: used to configure the Scan Station to use an
SMTP server. Configuration of an email server is required if you
will be sending documents to an email destination.

Active Directory Server: used to configure the location of an
Active Directory Server. This will be required if you want to define
users and groups of users from your Active Directory Server.

Fax: used to configure fax options. Fax configuration will be
required if you will be sending scanned documents via fax.

* Scan Settings — allows you to define items that determine how a
document will be scanned (e.g., black and white, two sided, 300 dpi,
etc.), the output format (e.g., PDF, JPEG, XLS, etc.), any special
processing, and how to name the scanned document. Multiple scan
settings can be configured. For example, you can setup a scan
setting configuration for scanning color documents, and another scan
setting configuration for scanning black and white documents. After
defining your scan setting configuration, you will be prompted to
name your configurations for later use. See “Chapter 5 Define Scan
Settings” on page 49 for more information.

* Index Templates — an index template is used to classify, sort, or
store the scanned documents in a particular order (referred to as
indexing). See “Chapter 6 Index Templates” on page 65 for more
information.

* Destinations — allows you to define where the scanned image(s) is
sent or stored. The Scan Station can send or store documents to
email, a network folder, printer, FTP, fax, email to fax, SharePoint,
and Kofax Front Office Server. See “Chapter 7 Create Destinations”
on page 81 for more information.

* Groups — groups are used to control access to jobs for specific
users or groups of users. See “Chapter 8 Add and Manage Groups”
on page 103 for more information.
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* Jobs — jobs are a combination of Scan Settings, Index Templates,
Destinations and Groups. A job is represented on the Scan Station
user interface as a single button, such as Invoices. A job allows one
touch scanning since a job will define how a document should be
scanned and formatted (Scan Settings), where the document should
be stored or sent (Destinations), and the users or groups of users
that are allowed to use a particular job (Groups). See “Chapter 9
Create Jobs” on page 109 for more information.

It is suggested that scan settings, index templates, destinations and
groups be defined before defining any jobs. Each Scan Setting, Index
Template, Destination and Group configuration will have an associated
name that will be used when defining a job.

The Scan Station can be configured to force a user to login. The login
information is matched with the groups defined for each job. When a
user logs into the Scan Station, the only buttons that will be displayed
are jobs that the user has access to.
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Scan Station
components

Front view

Input tray extender — pull this extender out to accommodate document
sizes over 8 1/2 x 11 inches (A4).

Input tray — holds up to 75 sheets of 80 g/m? (20 Ib.) paper.

Side guides — slide the guides back and forth to accommodate the width
of the documents you want to scan.

Touch screen — allows you to easily select a job or navigate through
optional selections with a simple touch. The touchscreen is the primary
user interface for interacting with the Scan Station.

Output tray panel — covers the transport when not in use. This panel
must be open to scan documents. When opened, collects the scanned
documents. The Scan Station cover cannot be opened when the output
tray panel is closed.

Output tray extender — pull this extender out when scanning documents
longer than 11 inches (28 cm).

Microphone — used for creating voice annotation.

Power — turns the power on. See “Indicator lights” on page 160 for more
information.
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Inside view

Separation module release lever/separation module — push the
release lever down to remove the separation module for cleaning or
replacement. The separation module provides smooth document feeding
and separation of various sizes, thicknesses and textures of documents.

Gap release lever — allows you to manually adjust the space between
the feed module and separation module for documents that require special
handling.

Scan Station cover release lever — opens the Scan Station to allow
access to the paper path for cleaning or clearing a document jam.

Feed module — provides smooth document feeding and separation of
various sizes, thicknesses and textures of documents.

Paper present sensor — detects the presence of documents in the input
tray.

Feed module cover — this cover needs to be removed when cleaning or
replacing the feed module or feed module tires.

Imaging guides — for optimum image quality, keep the upper and lower
imaging guides clean.

Multifeed detection sensor — detects if more than one document enters
the paper path at a time.
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Rear view

1 Modem port — the RJ-11 port connects the fax modem to a phone line.
This port is present only for the Scan Station 730EX, and only for serial
numbers earlier than 52190000.

2 Security lock port — connects a security lock to the Scan Station. You
can purchase a standard security lock at an office supply store. Refer to
the instructions provided with the security lock for installation procedures.

3 Power port — connects the power cord/adapter to the Scan Station.

USB ports — connects peripheral devices (e.g., keyboard, mouse and
other accessories) to the Scan Station.

5 Ethernet port — connects the Scan Station to the network.
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Chapter 2 Pre-installation Checklist

Network
configuration details

Best practices

Because the Scan Station is a network device, a basic knowledge of
networking principles and terminology is helpful. You should be familiar
with the concept of creating user accounts (on domains), sharing
folders, setting access privileges, the Universal Naming Convention
(UNC), using IP addresses, fully qualified domain names (FQDNs) and
creating user groups.

NOTE: Some of the concepts covered in this section assume
knowledge of Microsoft NT Domains and permissions. Refer to
your documentation for Microsoft Windows Server 2003, 2008
or 2012 for more information.

Scan Station user groups — for network domain environments, you
should create a user group for all Scan Stations. This group will be used
to hold account names that are assigned to each Scan Station.
Minimally, there should be one account name that is assigned to each
Scan Station. Optimally, each Scan Station should be assigned its own
unique username and password and these accounts should be
contained within a group that is reserved specifically for Scan Stations.
These account names will be used when configuring the Scan Station’s
network settings and entered into the Username, Password, and
Network Domain fields.

NOTE: The Scan Station groups and login names must be given
appropriate privileges to access the network resources that the
user will see as Destination selections at the Scan Station.

Workgroup environments — for network environments that use the
Microsoft “Workgroup” configuration, you may be required to create an
account name and password to be assigned to Scan Stations. These
account names will be used when configuring the Scan Station’s
network settings and entered into the Username and Password fields.
The Network Domain field should be left blank in Workgroup
environments.

Network folders — it is recommended that you create network folders,
for either Destination or Automatic Configuration Schedule updates,
that can be accessed (minimally read, write, change access) by any
Scan Station login account or by the user group created for Scan
Stations.
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UNC names for folders — you will need to know the fully qualified
UNC name for each network folder that will be used by your Scan
Station(s). When configuring network destinations, this will be the
information entered into the Enter a complete directory path field on the
Destinations screen. For example, you could create a folder called
“scanfolder’ on a server called “acmeserver’ that would be reserved for
Scan Station access. You would reference it by the following UNC
name: \\acmeserver\scanfolder.

NETBIOS usage — in network environments that use routers it is
common practice to block NETBIOS traffic on your router. You may
need to know the IP address of the server where you want to scan
documents. By substituting the IP address of the server instead of the
NETBIOS computer name, you can bypass the network traffic
restrictions that may cause network scanning to fail. For example, the
previously defined network address: \\acmeserver\scanfolder should be
replaced with something similar to: \\1192.168.2. 10\scanfolder.

Pre-installation It is recommended that you review this checklist before configuring the

checklist Kodak Scan Station 710/730EX. This information is needed to create
the initial configuration file to complete the installation. Locate any
information you are unsure of before creating the configuration file. See
your system or network administrator if you have questions about this
information.

Device Settings/IP Address
The following settings are found using the Scanner tab and by selecting Scanner>Modify Scanner.

Parameter Name Your Setting Chapter Reference

Automatic (DHCP) See “Modifying a Scan Station” on
page 121.

IP Address Settings — Static

Static (IPv4)
IP Address

Subnet Mask

Default Gateway
Preferred DNS Server
Alternate DNS Server
Preferred WINS Server
Alternate WINS Server

Device Settings/Network Destination Credentials

The following settings are found using the Configuration tab and by selecting Edit>Device Settings.

Parameter Name Your Setting Chapter Reference
Username, Password, Domain » See “Best practices” on page 9 for
Automatic Configuration creating an account for your Scan
Schedule Stat'?n' _ . C

» See “Configuring your device options
on page 33.
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Device Settings/Email (SMTP) Server

The following settings are found using the Configuration tab and by selecting Edit>Device Settings.

Parameter Name

Your Setting

Chapter Reference

Email Server Address

Username, Password, Domain

Port

See “Configuring email settings” on

Authentication Scheme

page 38.

Maximum Attachment Size

Security Type

Device Settings/Active Directory Server

The following settings are found using the Configuration tab and by selecting Edit>Device Settings.

Parameter Name

Your Setting

Chapter Reference

Server Address

Username, Password, Domain

Port

Base DN

Search Field Tag

See “Configuring Active Directory Server

Email Address Tag

settings” on page 41.

Full Name Field Tag

Home Directory Tag

Fax Field Tag

Security Type

The following settings are

Parameter Name

Device Settings/Fax
found using the Configuration tab and

Your Setting

by selecting Edit>Device Settings.

Chapter Reference

Outside Line Prefix

Modem Country Code

See “Configuring Fax settings” on

LAN Fax Server Domain Name

Parameter Name

Network Destination

Your Setting

page 43.

The following settings are found using the Configuration tab and by selecting Edit>Destinations.

Chapter Reference

Complete directory path (the
folder where you will put the
scanned documents).

See “Setting up a network destination” on
page 87.

A-61796 June 2017

11




Printer Destination

The following settings are found using the Configuration tab and by selecting Edit>Destinations.

Parameter Name Your Setting Chapter Reference

Complete directory path (the
directory path to the printer
server queue)

Username, Password, Domain

Address (for direct connection Chapter 7, “Setting up a printer
to a printer) destination”.

Driver name (for direct
connection to a printer)

Port name (for direct
connection to a printer)

FTP Destination

The following settings are found using the Configuration tab and by selecting Edit>Destinations.

Parameter Name Your Setting Chapter Reference

Server name and directory path

Username, Password
Protocol (FTP)
Port number

OBt Chapter 7, “Setting up a FTP site”.

Proxy

* Proxy Type

* Proxy Address
* Username

» Password

* Port Number

FTPS Destination

The following settings are found using the Configuration tab and by selecting Edit>Destinations.

Parameter Name Your Setting Chapter Reference

Server name and directory path

Username, Password
Protocol (FTPS)
Port number

Encryption

Passive (Enable/Disable)

SSL Server Certificate (Enable/
Disable)

Proxy

* Proxy Type

* Proxy Address
* Username

» Password

* Port Number

Chapter 7, “Setting up a FTP site”.
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SFTP Destination

The following settings are found using the Configuration tab and by selecting Edit>Destinations.

Parameter Name

Your Setting

Chapter Reference

Server name and directory path

Username, Password

Protocol (SFTP)

Port number

Private Key File, Password

Proxy

* Proxy Type

* Proxy Address
» Username

» Password

* Port Number

SharePoint Destination

Chapter 7, “Setting up a FTP site”.

The following settings are found using the Configuration tab and by selecting Edit>Destinations.

Parameter Name

Your Setting

Chapter Reference

SharePoint website URL

Username, Password

Document Path

Index Fields

Certificate, Password

Proxy

* Proxy Address
» Username

» Password

* Port Number

Kofax Front Office Server Destin

Chapter 7, “Adding a SharePoint group”.

ation

The following settings are found using the Configuration tab and by selecting Edit>Destinations.

Parameter Name

Your Setting

Chapter Reference

Kofax Front Office Server
address

Port number

Username, Password

Client ID

Shortcut Type

Shortcut Name

Index Fields

Certificate, Password

Chapter 7, “Adding a Kofax Front Office

Server group”.

A-61796 June 2017
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Chapter 3 Installation and Getting Started

Setup overview

Power saver mode
and activating the
Scan Station

Following is a list of things you need to do to prepare for configuring
your Scan Station 710/730EX.

Unpack your Scan Station(s) according to the unpacking instructions
in the box that your Scan Station was packaged in.

Setup the Scan Station and make the necessary connections. See
the Installation Guide or “Setting up the Scan Station” on page 2.

Review the pre-installation checklist in Chapter 2 and gather all of the
information required to configure the Scan Station. Having this
information available in advance will help ensure an easy Scan
Station configuration.

When the Scan Station is properly connected, press the power button
and wait a few moments for the Scan Station to start up and display
the application.

Install the Kodak Scan Station 700 Series - Scanner Administration
application on a separate PC. See “Installing the Kodak Scan Station
700 Series - Scanner Administration application” on page 21 for
procedures.

By default, after 15 minutes of inactivity, the Scan Station will
automatically enter into power saver mode.

To activate the Scan Station from power saver mode press the power
button.

A-61796 June 2017

15



Setup Wizard When the Scan Station is turned on for the first time, the setup wizard
automatically starts. It provides a step-by-step procedure allowing you
to select configuration options (i.e., time, date, etc.) when connecting to
the network.

Other configuration options are also required for Scan Station setup
(i.e., email and fax configurations, etc.); however, these options are
setup using the KSS700 - Scanner Administration application.
Procedures regarding these additional settings are explained in more
detail later in this chapter.

NOTES:

* The procedures that follow are only for the first time you turn on your
Scan Station.

* For detailed information regarding any of the following settings, see
the section entitled, “Configuring your Scan Station” later in this
chapter.

* If Run the wizard at next boot-up is enabled, the wizard will start at
the next power up.

1. Upon startup the Language screen will be displayed. Select the
language that you want the Scan Station user interface to be display
in, then click Done.

Select the default language.

German VN

Dutch

English

Spanish

French

Italian

Japanese
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2. The following screen will be displayed. Select any of the options you
want to configure:

Select the items that you would like to configure.

Device Name oA
Date

Time Zone

Time

Local Access Password

Network Settings

Device Name: allows you to enter the device name.

Date: allows you to set the date on the Scan Station.

Time Zone: allows you to select the desired time zone.

Time: allows you to set the time on the Scan Station.

Local Access Password: allows you to set a password that
provides access to the Scan Station. (See “Configuring your
device options” on page 33 for more information about the Local

Access Password.)

Network Settings: allows you to configure the Scan Station’s
network address.

After you select the options you want to configure, click Done and
the screen associated with the first selected option will be
displayed.

3. If you selected Device Name, a keyboard will be displayed. Enter
the name of the device then click Next. .

[<SS52184015]

o
H
m
F
-
<
&
-
o
o
N
©
©

> >
o

) Previous W Next
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4. If you selected Date, the Date screen will be displayed. Enter the
desired date and click Next.

06/ | 01/ 2017

Set the date.

«Q 7 8 9
4 5 6
1 7 3
/ 0
(D Previous P> Next

5. If you selected Time Zone, the following screen will be displayed.
Select the desired time zone and click Next.

Select the default time zone.

(UTC-03:00) Cayenne, Fortaleza Y @
(UTC-03:00) Brasilia

(UTC-02:00) Mid-Atlantic

(UTC-01:00) Cape Verde Is.

(UTC-01:00) Azores

(UTC) Monrovia, Reykjavik

(UTC) Dublin, Edinburgh, Lisbon, London

1/

(D Previous Next

4

6. If you selected Time, the following screen will be displayed. Enter
the desired time and click Next.

4 |: 56 |: 59 PM
Set the time.
a 7l 8l o
AM 4 5 6
PM i) 7 8
0
) Previous (@ Next
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7. If you selected Local Access Password, the following screen will
be displayed. Enter the desired password and click Next.

Enter New: Set the device/administrator password.

o>
N
x
0
<
«
z
4
®
i#

4 com .net _ B | ) ’ ok

) Previous Next

8. The password confirmation screen will be displayed. Enter the
password again and click Next.

Confirm New: Set the ini password.

(b
N
x
o
<
@
z
2
®
#

) Previous Next

A4

9. The following screen will be displayed. Select Obtain an IP
Address automatically to use DHCP to obtain an IP address to
connect to the network, or Assign an IP Address to enable you to
enter the desired IP address. Click Next..

How would you like to connect to the network?

Obtain an IP Address automatically o

Assign an IP Address

v

) Previous @ Next
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10. The following screen will be displayed. Enter the required IP
Address, Subnet Mask, Default Gateway, and Preferred DNS
Server information. Click Done.

Please enter an IP Address, Subnet Mask, Default Gateway and Preferred DNS Address.

Static IP Address

IP Address A
10.234.12.29

Subnet Mask
255:255:255:0]

Default Gateway
Preferred DNS Server
Alternate DNS Server

Preferred WINS Server

Alternate WINS Server

Done Cancel

11. The information will be processed. A screen summarizing your
settings will be displayed. Click Yes to accept your selections.

Setup Summary:

Scanner Name: KSS52184015

Date: 6/1/2017

Time: 4:59 PM - (UTC) Dublin, Edinburgh, Lisbon, London
Local Access Password: changed

IP Address: 10.234.12.29

Are the settings correct?

12.When all desired setting have been made, continue with the Scan
Station installation. See the next section, “Installing the Kodak Scan
Station 700 - Scanner Administration application”.
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Installing the You must install the Kodak Scan Station 700 Series - Scanner

Kodak Scan Station Administration application on a host PC. The Kodak Scan Station 700

700 Series - Scanner Series - Scanner Administration application allows you to properly

o, . setup, configure and manage Scan Station 700/710/720EX/730EX/500/

Administration 520EX devices over a network in an efficient and productive manner.

application This application communicates with Kodak Scan Station 500 and 700
devices over the network; thereby minimizing the need for individual
access to multiple Scan Stations.

1. Insert the Installation CD titled, “Scanner Administration and
Supporting Documentation” in the CD-ROM drive on the computer
where the Kodak Scan Station 700 Series - Scanner Administration
application will be installed. The installation software starts up
automatically.

NOTE: If .NET Framework 4.0 is not already installed, the Kodak
Scan Station 700 Series - Scanner Administration
application installer will install them before installing the
Kodak Scan Station 700 Series- Scanner Administration
application.

2. Click Next when the Kodak Scan Station 700 Series splash screen
is displayed.

3. Click Next when the Welcome screen is displayed.

4. Click | Agree after you have read and agreed with the terms of the
Software License Agreement, then click Next.

The Ready to Install Program screen will be displayed.
5. Click Install to continue.

6. After the Kodak Scan Station 700 Series - Scanner Administration
application has been installed, click Finish.

7. Remove the Installation CD from the CD-ROM drive.

8. After installing and running the application, the Kodak Scan Station
700 Series - Scanner Administration main screen will be displayed.

' KODAK Scan Station 700 Series - Scanner Administration
File Edit Scanner Help
|| Scanners Corfiguration ]

Select a configuration:

My scan station configuration |
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The main screen The main screen provides two tabs:

+ Scanners tab — allows you to monitor any Scan Stations that have
been discovered and configured. See “Chapter 10 Monitor and
Manage Your Scan Stations” on page 115for more information.

NOTE: In addition to the Scan Station 710/730EX, the Kodak Scan
Station 500/520EX/700/720EX can be managed from the
Scanner tab and the Scanner menu.

~
nner Administration =REC X

& KODAK Scan Station 70

File Edit Scanner Help

{ Seamners | Configuration |

CXUC 00 i

Scanner IPAddress | DHCP | HTTPS | Scamner Model | Status | Last Command Comment |

p
Retrieve Logs - 6/9/2014 q
s [mmma] @[T e e R =

KS551002806 15010277175 | o T20EX Mot Found 00224D

KSS52151103  [150.102.77.178| o 700 Not Found |5 et 3/13/2015 00224D

al | il

» Configuration tab — allows you to configure and set up your Scan
Stations. This screen will be displayed with a list of your previously
created configurations.

NOTE: The Configuration tab and the File and Edit menus only apply
to the Scan Station 700/710/720EX/730EX.

The Scan Station 500/520EX must be configured using the
Kodak Scan Station Configuration Organizer. See your
Administrator’'s Guide for the Kodak 500/520EX for more
information.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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A configuration is a collection of Device settings, Scan settings,
Index Templates, Destinations, Groups, and Job settings.
Configurations are stored on your PC in a configuration database
and maintained by the Kodak Scan Station 700 Series - Scanner

Administration application. Detailed procedures for configuring these
settings are described in Chapters 4-9.

File Edit Scanner  Help

Scanners  Configuration |

Select a configuration:

scan station configuration
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Menus The File, Edit, Scanner and Help menus are available from the Kodak
Scan Station 700 Series - Scanner Administration main screen.

NOTE: When the Configuration tab is selected, only the File, Edit and
Help menus are available.

When the Scanners tab is selected, only the Scanner and Help
menus are available.

File menu Following is a description of the menu options on the File menu.
File | Edit Scanner Add — allows you to create a new configuration from the default or

Add N from an existing configuration.

Save * From default configuration: when selected, displays the Device
Settings screen with a default configuration. For more information

Rename... see “Device Settings” on page 31.

Drelet

== * From selected configuration: when selected, displays the

Import... Configuration Name screen which allows you to name a new

Export... configuration which is based on the currently selected configuration.
If you want to base a new configuration on an existing one (not the

Exit default), select an existing configuration, then select File>Add>From

the selected configuration. If there are no configurations (other
than the default), this option is grayed out.

Save — saves the selected configuration to the configuration database
located on the PC running the Kodak Scan Station 700 Series -
Scanner Administration application. This option is only available for
configurations that have changed (marked with an asterisk).

Rename — displays the Configuration Name screen allowing you to
rename the selected configuration.

Delete — deletes the selected configuration.

Import — allows you to import a configuration file from any location to
the Kodak Scan Station 700 Series - Scanner Administration
application.

Export — allows you to export a configuration file from the Kodak Scan
Station 700 Series - Scanner Administration application to any location.

Exit — closes the Kodak Scan Station 700 Series - Scanner
Administration application.
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Edit menu

Edit | Scanner Help

Device Settings...
Scan Settings...
Index Ternplates...
Destinations...
Groups...

lobs...

Scanner menu

Scanner | Help

Add Scanner...
Discover Devices..,
Madify Scanner...

Delete Scanner...
Upload configuration...

Rernote Access Password...
Refresh Status...

Refresh Rate...

HTTP Timeout...

HTTPS

Device

Power Options

Upload Firmware...

Remote Application Installation...

Following is a description of the menu options on the Edit menu.

Device Settings — allows you to configure the parameters that the
Scan Station needs to send emails, communicate with an Active
Directory Server for security purposes, set Scan Station defaults and
configure fax settings. For more information, see “Device Settings” on
page 31.

Scan Settings — allows you to set basic image processing settings,
such as, color/grayscale/black and white, output file format,
compression, and advanced options like Hole Fill, Streak Filter, etc. For
more information, see “Scan Settings” on page 51.

Index Templates — allows you to define bar code and OCR areas on a
document that can then be used to dynamically construct a file path
name for saving scanned documents. For more information, see
“Chapter 6 Index Templates” on page 65.

Destinations — allows you to add or modify destinations (e.g., email,
network folder, printer, FTP site, etc.) that define where the scanned
output will be sent. For more information, see “Chapter 7 Create
Destinations” on page 81.

Groups — allows you to create or modify a group of users from an
Active Directory Server. Other users that are not in an Active Directory
Server group can also be added. For more information, see “Chapter 8
Add and Manage Groups” on page 103.

Jobs — allows you to create or modify jobs which are a collection of
scan settings, index templates, destinations and groups of users. For
more information, see “Chapter 9 Create Jobs” on page 109.

Following is a description of the menu options on the Scanner menu.
Refer to “Chapter 10 Monitor and Manage Your Scan Stations” on
page 115 for more information and procedures regarding these options.

Add Scanner — displays the Add Scanner dialog box, which allows
you to register Scan Stations that you want to manage remotely.

Discover Devices — allows you to scan a range of IP addresses and
automatically register any Scan Station within that range that responds
to the request.

NOTE: Any Scan Station that has previously had its Remote Access
Password set will not respond to the discovery request. If this is
the case, you will need to manually add the Scan Station by
selecting Scanner>Add Scanner and enter the Scan Station’s
name or |IP address and the Scan Station’s password.

Modify Scanner — allows you to rename the selected Scan Station
and configure network settings.

Delete Scanner — deletes the selected Scan Station(s) from the list of
administered Scan Stations.

Upload configuration — sends the configuration to the selected Scan

Stations.

NOTE: If the Scan Station is in power saver mode, you can select
Scanner>Upload configuration to wake up the Scan Station.
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Remote Access Password — displays the Remote Access Password
dialog box which allows you to change the network connection
password to the Scan Station.

This password is used by the Kodak Scan Station 700 Series - Scanner
Administration to communicate with the Scan Station. An organization
can have more than one instance of the Scanner Administration
software running at one time. Only those instances that are aware of
the password for a particular Scan Station can communicate with that
Scan Station. If a Scan Station with a Remote Access Password is
deleted from the grid view, the password will be required to add the
Scan Station back to the grid view. For more information, see “Grid
view” on page 117.

Refresh Status — displays the current state of the selected Scan

Station(s):

* Idle — the Scan Station is currently active on the network; but not in
use.

NOTE: Any user interaction using the touch screen will put the
Scan Station into the In Use state (see below).
+ Scanning — Scan Station is scanning.

* Processing images — the Scan Station is processing images (e.g.,
converting images to PDF).

¢ Sending email — the Scan Station is sending an email.

e Saving — images are being saved to a USB drive, network folder,
FTP site, or a SharePoint site.

* Printing — the Scan Station is printing images using a remote
printer.

¢ Scan Completed — the Scan Station has successfully completed
the scanning session. When Done is selected on the Scan Station,
the Scan Station will go into the I/dle state.

* Error — the Scan Station failed to complete the scanning session.
When Done is selected on the Scan Station, the Scan Station will go
into the /dle state.

* Cancelled — the scanning session has been cancelled. After the
inactivity time period has been reached, the Scan Station will go into
the Idle state.

* Preview — the Scan Station Preview feature is in use.

* Sending Fax — the Scan Station is sending a fax. This is only
displayed if the Scan Station is not currently scanning.

* Receiving Fax — the Scan Station is receiving a fax. This is only
displayed if the Scan Station is not currently scanning.

* Powering down — the Scan Station is in the process of a power-
down sequence.

* Rebooting — the Scan Station is in the process of being restarted.
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» Updating — the configuration file or firmware is currently being
updated.

¢ In Use — when a USB flash drive is inserted, a user is logging in or is
interacting with the Scan Station, this state is displayed.

* Not found — the Scan Station cannot be found on the network (e.g.,
power is turned off).

Refresh Rate — allows you to set the frequency that the application
will try and communicate with all Scan Stations.

HTTP Timeout — allows you to adjust the amount of time (in seconds)
that the HTTP commands have to complete. If some commands
timeout and do not complete, adjust this to a higher value.

HTTPS — turning HTTPS on will encrypt data as it is communicated
between the Kodak Scan Station 700 Series - Scanner Administration
application and the Scan Station.

Device — provides the following options. Procedures on how to use
these functions are described in Chapter 10, Monitoring and Managing
Your Scan Stations.

Scanner | Help

Add Scanner...

Discover Devices...
Modify Scanner..,

Delete Scanner...

Upload configuration...

Remote Access Password...

Refresh Status... F5
Refresh Rate...

HTTP Timeout...

HTTPS »

Device 4 Retrieve Logs...

Power Options 4 Clear Logs...

Upload Firmware... Retrieve Transaction Logs...

Remote Application Installation... Clear Transaction Logs..

Save All Logs...

Details...

Update Time/Date...

* Retrieve Logs: allows you to save the log files retrieved from the
selected Scan Station.

» Clear Logs: when selected, the following message will be displayed,
Are you sure you want to clear the log files of the selected
scanner? If you click Yes, the log files will be cleared.

* Retrieve Transaction Logs: allows you to save the transaction log
file retrieved from the selected Scan Station.

» Clear Transaction Logs: when selected, the following message will
be displayed, Are you sure you want to clear the transaction log
files of the selected scanner? If you click Yes, the transaction log
files will be cleared.

+ Save All Logs: saves all available log files found on the selected
Scan Stations and saves them to the selected directory. The logs will
be saved in the selected directory under the Device Name folder of
the Scan Station.
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» Details: provides device information about the selected Scan
Stations including network configuration, software versions and page
count.

» Update Time/Date: allows you to set the NTP time server for all
selected Scan Stations.

Power Options — provides options for restarting and turning off the
selected Scan Stations.

Upload Firmware — displays the Open dialog box which allows you to
upload new firmware updates to the Scan Station.

Remote Application Installation — allows you to download a third
party application.

Help menu Following is a description of the menu options on the Help menu.
Help | Contents — provides help topics for the Kodak Scan Station 700

Conterts.. Fl Series - Scanner Administration.

Index — provides help topics for the Kodak Scan Station 700 Series -
Scanner Administration.

% About — displays the About screen for the Kodak Scan Station 700
Series - Scanner Administration application, which provides information
about the current version of the software.

Index...

Icons The information in Chapters 4-9 outline a step-by-step procedure for
setting up your Scan Stations. Most screens have one or more of the
following icons.

- | Creates a new entity.
Y, Edits an existing entity.

'l_l Deletes the selected entity.

Displays the current state of the Scan Station:
«  -ide

» Scanning

* Processing images

» Sending email

» Saving

* Printing

» Scan Completed

* Error

» Cancelled

* Preview

» Sending Fax

* Receiving Fax

» Powering down

* Rebooting

» Updating

* In Use

* Not found
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Retrieves, displays and allows the saving of the log file on the
selected Scan Station.

Displays and allows the saving of the transaction log file on the
selected Scan Station.

Displays detailed information about the selected Scan Station
(e.g., software version, IP address, etc.).

Allows you to send the selected configuration to the Scan
Station. This option is grayed out if no Scan Stations are
accessible by the Kodak Scan Station 700 Series - Scanner
Administration application.
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Chapter 4 Configure Device Settings

Device Settings The Device Settings option allows you to configure the Scan Station for
sending emails, sending and receiving faxes, communicating with the
Edit | Scanner Help Active Directory Server for authentication purposes, creating index
| Device Setfings... | templates and setting up Scan Station defaults.
Scan Settings...

| & KODAK Scan Station 700 Series - Scanner Administratior [
Index Templates... e nniBB———————————e
: . File Edit Scanner  Help
Destinations... o
Scanners  Configuration 1

Groups... Select a configuration:
Jobs...

To set up a configuration:

1. Select the configuration that you want to apply settings to or create
a new configuration (File>Add).

2. Select Edit>Device Settings.

& KODAK Scan Station 700 Series - Scanner Administration ==

Device Settings ‘

Select the Device Settings to configure
[C] Device Options
[Z] Email Server

[ Active Directory Server
[ Fax
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Check all options that you want to configure and click Next. The
software will step you through each option.

» Device Options — allows you to set the following options:
- Language
- Local Access Password
- Network Destination Credentials
- Network Information
- Automatic Configuration Schedule
- Volume
- Configuration Options
- Date and Time
- Power Saver

« Email Server — for the Scan Station to send documents to email
recipients, you must define how the Scan Station will access your
email server (e.g., SMTP, Return Email Address, etc.).

+ Active Directory Server — allows you to configure your connection
to the Active Directory Server which allows the Scan Station to
authenticate credentials and look up specific user information, such
as their home directory on the network.

» Fax — allows you to configure the Scan Station to send and receive
faxes.
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Configuring your device

options

This screen allows you to setup the following device options:

§ KODAK Scan Station 700 Series - Scanner Administration

+ | Language

v ) Date
v ) Time

~ | Power Saver

Device Settings

v | Local Access Password

v | Network Destination Credentials
v | Network Information

v | Automatic Configuration Schedule
+ | Volume (5500 only)

v | Configuration Cptions

|

| Cancel

| | Previous | | Finish |

Language — click the down arrow to select the language that will be
used on the Scan Station display.

i~ | Language

Language:

|English

Local Access Password — allows you to set a password that controls
administrator access to the Scan Station.

) Local Access Password

Password:

Confirm new password:

Force User Local Access Local Access Password
Login Password Set Blank (default)

On The user must login into the The user will login into the Scan
Scan Station with their user Station with their user name
name and password. The local |and password. No password is
access password is required to |required to update the Scan
update the Scan Station if a Station if a USB drive
user inserts a USB drive containing a configuration file is
containing a configuration file. |inserted.

Off Local access password is No access control.

required to apply a
configuration file at the Scan
Station with a USB flash drive
containing a configuration file.

It is recommended that a local access password be set to guard against a non-
privileged user from gaining access to administrator functions.
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Network Destination Credentials — when selected, define the
Username, Password and Domain required to access network
resources.

| Metwork Destination Credentials

Username:
Password:

Comain:

NOTE: This is only used for network folders when Force User Login
(on the Active Directory Server screen) is not enabled.

1. Enter the network user name assigned to the Scan Station. For
more information see “Network configuration details” on page 9.

NOTE: If you want the Scan Station to have access to network
printers or network shared folders, the credentials provided
must have sufficient privileges to access these resources.

2. Enter the password for the network user name in the Password
field.

NOTE: This password is only used by the Scan Station and will
never be displayed in readable form. The password is
stored in encrypted format.

3. Enter the Microsoft network domain name which the Scan Station
will be connected to in the Domain field. In a workgroup
environment, this field can be left blank.

Network Information — allows you to define DNS suffixes to search
for name resolution.

# | Network Information

DINS Suffixes (comma separated):

Automatic Configuration Schedule — the Scan Station can be
configured to look for firmware updates and an updated configuration
on specific days and times. Select this option to allow your Scan Station
to automatically look for an updated configuration.

| Automatic Configuration Schedule

Folder:

Dayl(s): | Every Day =

Tirme of Day: | 07 % d 00 %

1. Enter a network folder where the Scan Station will find updated
configuration settings.

2. Select which day(s) of the week this operation will be performed.

3. Select the time of day you want your Scan Station to check for
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updates.

NOTE: When updating a configuration using this method, the fields
on the Add Scanner and Modify Scanner dialog boxes will
not be updated: Scanner Name, IP Address and Remote
Access Password.

Volume (SS500 only) — allows you to adjust the master volume of the
Scan Station 500. This will affect the speaker sound from the FAX
modem and voice annotation playback.

# | Volurne (55500 cnly)

Vaolume 15 %

NOTE: If you do not hear the fax dial tone after changing the volume,
you may need to restart the Scan Station.

Configuration Options — provides the following options

{ ~ | Configuration Options

Select the iterns below that you want to restrict access to or enable

| Allow File Naming
| Allow saving to USB drive
Hide Metwork Folder location
Fast Scanning (one button press scanning)
V| Allow Voice Annotation
Enable Restricted mode (users cannot select or change destinations)
Allow SharePzint index field changes

Allow Kofax Front Office Server index field changes

| Log all transactions
| Background processing

Run the Setup Wizard at next restart

¥ Enable output metadata o

+ Allow File Naming — if enabled, allows a user to configure file name
options on both the Scan Station and the Kodak Scan Station 700
Series - Scanner Administration.

» Allow Saving to USB drive — allows you to enable scanning to a
USB drive. This may be useful in more secure environments where
tighter control is required.

* Hide Network Folder location — enable this option to provide a
more secure environment by partially hiding the location of the
network folder. If this option is enabled, only the end of the network
folder path will be displayed on the Scan Station touchscreen. For
example: \\server\myfolder will be displayed as: ...\myfolder.

* Fast Scanning (one button press scanning) — allows a user to
scan instantly without waiting for the 10-second delay, the Settings
Review screen or the Destination Review screen to be displayed. A
message will only be displayed if the scan session was unsuccessful.
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« Allow Voice Annotation — when enabled, allows a user to record a
voice annotation for each batch of scanned documents. By default,
this option is enabled.

* Enable Restricted mode (users cannot select or change
destinations) — when enabled, will only allow users to select a pre-
defined job from the Scan Station touchscreen. These jobs cannot be
changed by the user.

» Allow SharePoint index field changes — when enabled, allows a
user to change existing index fields.

» Allow Kofax Front Office Server index field changes — when
enabled, allows a user to change existing index fields.

* Log all transactions — the Scan Station can log all transactions (all
activity related to login, scanning and saving to destinations) to a
separate transaction file. This file is in XML format and can be
downloaded from the Scan Station. This is useful in environments
that are security-minded or where transactions are used for billing. By
default, all transactions are logged (checked). You can disable
transaction logging by unchecking the checkbox.

» Background processing — allows you to select how jobs are
processed. If background processing is selected, all jobs will be
submitted to a queue and, by default, be processed in a first in, first
out (FIFO) manner. This allows a user to start a second scan job
immediately after the first job is scanned, even if the first scan job is
still being processing.

* Run the Setup Wizard at next restart — when selected, the Setup
Wizard will run when the Scan Station restarts, which provides a
step-by-step procedure allowing you to select configuration options
(e.g., time, date, etc.) when the Scan Station is restarted.

NOTE: The Setup Wizard is run from the Scan Station (not the
Kodak Scan Station 700 Series - Scanner Administration
application).

* Enable output metadata — with each document scanned, a .xml file
will be created and sent to the destination along with the scan file. A
.xsd file that can be used for metadata verification is on the
Installation CD.

» Allow email selection in Jobs mode — allows you to display all of
the email destinations that are configured for a Job along with the
ability to add additional email destinations using an Active Directory
search. This option only works in Jobs mode and appears after the
Job begins.
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Date — allows you to set the date format on the Scan Station.

i » ) Date

Date Separator: = = |
Date Format wyyy-mm-dd "|

1. From the Date Separator drop-down list, select a symbol to use as a
separator in the date format.

2. Select how you want the date displayed on the Scan Station
touchscreen by selecting a format (year, month, day) from the Date
Format drop-down list.

Time — allows you to set the time format on the Scan Station.

[~ Time

Time Zone: I[UTC} Dublin, Edinburgh, Lisbon, London -

Daylight Savings:

i
Clock: .24 Hour = |
Time Separator: .: '|
Time Format .hh:mm:ss '|

1. Select the Time Zone based on the Scan Station’s location.

NOTE: If Scan Stations are located in different time zones,
separate configuration files will be necessary.

2. If you want the Scan Station to automatically adjust for daylight
savings time, check the Daylight Savings check box.

3. Select either 12 Hour or 24 Hour time format from the Clock drop-
down list.

4. Select the desired separator symbol that will be displayed in the
time format from the Time Separator drop-down list.

5. Select the hours, minutes, seconds of how you want the time format
to be displayed: hh:mm:ss, h:mm:ss, hh:mm or h:mm.

Power Saver — use the up and down arrows to set the amount of time
the Scan Station needs to be inactive before it goes into power saver
mode. The default is 15 minutes.

{ »~ | Pawer Saver

Power Saver (Minutes): 15 %

Depending on the options you selected on the main Device Settings
screen, you will have the option of clicking Next which will display the
next device you want to configure, or Finish which will return you to the
Configuration tab.
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Configuring email

For the Scan Station to send documents to email recipients, you must

settings define how the Scan Station will access your email server.

1. Check Email Server and click Next.

‘ KODAK Scan Station 700 Series - Scanner Administration Iﬁ‘
Device Settings >,

Email Server Address: Myemailaddress

Username:

Password:

Domain:

Port: | 25 %

Authentication Scheme: IUSE Strongest -

Security Type: None = | m|

Maximum Attachment Size (MB): | 25 %

Return Email Address:

Allow Custom Email Addresses: |

Allow Custom Email Subject: i

Destination Motification:

I Cancel ‘ I Previous | Finish |

2. Enter an IP address or a fully qualified domain name of your SMTP
server in the Email Server Address field.

3. If your SMTP server requires it, enter a Username, Password and
an optional Domain name for the email server account that the
Scan Station will log into.

4. Most email servers communicate on port 25. If your email server
communicates on a different port, select the desired port number.

5. Select Authentication Scheme to select the specific SMTP
Authentication Scheme used by your email server. Select from the
following options:

+ Use Strongest

 None

« Plain

* Login

+ MD5 Challenge Response

« NTLM

NOTE: Use Strongest will select the strongest available
authentication scheme reported by the email server. For
more information on authentication schemes, consult your
network administrator.

6. Use the up and down arrows to select the desired Maximum
Attachment Size of an email attachment that can be sent
successfully (1 to 99 MB in 1 MB increments).
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7. Enter the email address where you want a notification to be sent
that an email could not be delivered by the Scan Station in the
Return Email Address field. This email address will also be put in
the From field on the email.

8. If you want the user to have the ability to enter an email address that
is not currently in the address book, check the Allow custom Email
Addresses checkbox.

9. If you want the user to have the ability to enter information in the
subject line when scanning to email destinations, check the Allow
custom Email Subject checkbox.

10. Select the security type to setup a secure connection to your email
server. Selections are: None, SSL or Use StartTLS.

» SSL.: select this option if your email server requires Secure
Socket Layer (SSL).

» Use StartTLS: select this option if you want to enable a secure
SMTP connection.

NOTE: If selected, make sure your email server is configured to
use StartTLS. If it is not, the Scan Station will fail to send an
email.

11. If email notifications of success or failure are required, you can
make a selection in the Destination Notification fields.

Destination Notification:
Email Address:
Prompt for Email Address: v
Success: v

Failure: v

« Email Address: enter the email address for the destination
notifications. If there is an entry in this field, and the user also
enters a notification email address before scanning, the
notification will go to both email addresses.

* Prompt for Email Address: if checked, the user can enter a
notification email address before scanning.

» Success: if checked, an email notification will be sent whenever
a destination is successful.

« Failure: if checked, an email notification will be sent whenever a
destination was not delivered successfully.
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NOTES:

» Email destination notifications are sent only when Background
Processing is enabled.

* |f Success and Failure are both unchecked, an email notification
will not be sent.

* If Success is checked and you are outputting to several
destinations, you will only receive a success notification if all the
destinations were successful. If any one of them fails, a
notification will not be sent.

+ If Fast Scanning is enabled, the user cannot enter a notification
email address before scanning.

« |If the Email Address field is set and the user enters a notification
email address before scanning, notifications will be sent to both
email addresses.

» For email destinations, the notification message, “Email
message(s) have been queued’ will be displayed.

» For fax destinations, the notification message, “Fax(s) have
been queued’ will be displayed.

» Email destinations use the Return Email Address field in the
Email Server settings when an email cannot be delivered.

« Fax destinations use the Fax Notification Email Address field in
the Fax settings when a fax cannot be delivered.

12.Click Test Connection if you want to check to be sure your settings
are correct. When finished, a Success or Failure message will be
displayed. If the test connection failed, verify that all of your settings
are correct and make any necessary changes, until a Success
message is displayed.

NOTE: You may need to use the scroll bar to access the Test
Connection button.

Depending on the options you selected on the main Device Settings
screen, you will have the option of clicking Next which will display the
next device you want to configure, or Finish which will return you to the
Configuration tab.
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Configuring Active
Directory Server settings

If you selected to configure the Active Directory Server, proceed with
the following steps. If not, go to the section that describes the next
device you want to configure.

The Active Directory Server allows you to setup a central location for
network administration and security.

,
s e

Device Settings >-

Active Directory Server Address:

Username:
Password:
Domain:

Port: | 389 %

Base DMN:

m

Search Field Tag: sn

Email Address Tag: mail

Full Name Field Tag: displayname
Home Directory Tag: HomeDirectory

Fax Field Tag: facsimiletelephonenumber

Search Results To Retum: |50 ,Ei

[ Cancel | [ Previous |

1. Enter an IP address or a fully qualified domain name in the Active
Directory Server Address field.

2. If your server requires it, enter a Username, Password and an
optional Domain name for the Active Directory Server account that
the Scan Station will log into.

3. Most Active Directory Servers communicate on port 389. If your
Active Directory Server communicates on a different port, select the
desired port number.

4. The Base DN (Distinguished Name), Search Field Tag, Email
Address Tag, and Full Name Field Tag are strings that define the
search criteria for the Active Directory Server. See your network
administrator for the specific format of these strings. When you have
the correct format, enter the Base DN, Search Field Tag, Email
Address Tag and Full Name Field Tag.

5. In the Home Directory Tag field enter the name of the tag in your
Active Directory Server that defines where the user’s home directory
is located. This requires the home directory to be defined in your
Active Directory Server database.

If Force User Login is checked, when the user logs into the Scan
Station, their home directory will automatically be used as their
destination.
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6. Enter the Active Directory Server Fax Field Tag for the tag to use
when searching the Active Directory Server for fax numbers. For
more information, contact your network administrator for the exact
string to use (e.g., facsimiletelephonenumber).

7. Select the maximum number of records to display when performing
a search from the Search Results To Return field. Select a number
from 1 to 1000.

NOTE: You may need to use the scroll bar to access the Security
Type, Force User Login and the Test Connection options.

8. Select the Security Type to setup a secure connection to your
Active Directory Server. Selections are: None, SSL or TLS.

» If you select SSL or TLS, the Ceritificate and Certificate
Password fields will be displayed allowing you to select a
certificate file.

» Some certificates require a password. If your certificate requires
a password, enter the password.

9. If you check Force User Login, it requires the user to login before
beginning a scan session. At login, the user will have to enter a user
name, password and domain. These credentials will be used to
access network resources.

NOTE: A default administrator account is available for logging onto
the Scan Station after enabling Force User Login. Initially
the Local Access password will be “blank” and it is up to
you to set this password to prevent user access to
administrative functions. For information on this Local
Access password, see “Configuring your device options” on
page 33.

10.Check User Home Directory to have the Scan Station
automatically create a destination for the logged in user’'s home
directory (which is extracted from Active Directory). This can be
enabled if Force User Login is checked.

11. Check User Email Address to have the Scan Station automatically
create an email for the logged in user (which is extracted from
Active Directory). This can be enabled if Force User Login is
checked.

12.Check Allow Email Search to allow the user to do email searches
on the Scan Station when sending to email destinations.

13.Click Test Connection if you want to check to be sure your settings
are correct. When finished, a Success or Failure message will be
displayed. If the test connection failed, verify that all of your settings
are correct and make any necessary changes, until a Success
message is displayed.

Depending on the options you selected on the main Device Settings
screen, you will have the option of clicking Next which will display the
next option you want to configure, or Finish which will return you to the
Configuration tab.
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Configuring Fax settings

Email to fax

Email to fax is available for all Scan Station 700 series scanners.

If you have a Scan Station 730EX with a modem?, fax settings can be
configured to allow the Scan Station to send and receive faxes.

If you use an email-to-fax service (e.g., Nextiva), fax settings can be
configured to allow the Scan Station to send email of scanned images
to fax destinations over a Local Area Network (LAN).

‘ KODAK Scan Station 700 Series - Scanner Administration

X ]

Device Settings

LAN Fax Server Domain Name:

Sender's Fax Numben:
OQutside Line Prefix
Modem Country Code:

Fax Failure Retries:

Fax Notification Email Address:
Allow Fax Notification:
Allow Custom Fax Numbers:

Maximum Port Speed:

Delay Between Retries {minutes):

Wait for dial tone before dialing:

P

nextivafax.com

United States (B3) >

0

0

sam.giardina@kodakalaris.com
[El

[E

115200 hd

£l

| Cancel | | Frevious Next

1. Enter the LAN fax server domain name.

NOTE: This option works only for an email-to-fax service sending
to a fax number on a domain where no login is required.

1.Scan Station 730EX units with a serial number earlier than
52190000 are equipped with a modem. If the back panel of your scan-
ner does not have a modem port, the scanner does not have a
modem. See “Rear view” on page 7.
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Sending faxes from the
Scan Station 730EX

2. If your Scan Station does not have a modem, click Next. The

following screen will be displayed. Click No — you will not be
receiving faxes if your scanner has no modem.

KODAK Scan Station 700 Series - Scanner Administratio

Device Settings

Will the Scan Station be used for receiving faxes?

O Yes
@ No

Cancel | Previous ‘ Finish ‘

3. Click Finish.

NOTE: If your Scan Station does not have a modem, you should ignore
the remainder of this chapter. Configuration settings to send and
receive faxes will work only for Scan Stations with modems.

1. In the Device Settings screen, enter a fax number in the Sender’s
Fax Number field. This number will be displayed on the banner of

outgoing faxes.
o)

‘ KODAK Scan Station 700 Series - Scanner Administration

Device Settings

LAN Fax Server Domain Name: nextivafax.com

Sender's Fax Mumber:

Outside Line Prefix

Modem Country Code:

Fax Failure Retries:

Delay Between Retries (minutes):
Fax Notification Email Address:
Allow Fax Notification:

Allow Custom Fax Numbers:
Maximum Port Speed:

Wiait for dial tone before dialing:

United States (B3)

0
0

sar.giardina@kodakalaris.com

115200 >

€]

Cancel | | Previous 1 Next

Do ]
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2. If your phone system requires a number to get an outside line, enter
the prefix that the user needs to enter, to access an outside line

(e.g., 9 is frequently used and a comma

,” may be used to insert a

pause) in the Outside Line Prefix field. Each comma pauses the
dialing sequence for about 3 seconds. You can use multiple
commas to increase the pause time, for example “9,,,”.

3. Select Modem Country Code to display a list of countries and the
associated codes that configure the modem for use in the selected

country.

4. Enter the number of times the Scan Station will attempt to send a
fax in the Fax Failure Retries field.

5. Enter the number of minutes the Scan Station will wait between
attempting to send a fax in the Delay Between Retries field.

6. If you want someone to be notified every time a fax is sent (Success
or Failure), enter the email address of the person/group who should
be notified in the Fax Notification Email Address field.

7. Check Allow Fax Notification if you want the user to be able to
specify an email address, printer or both for Success and Failure
notifications. Refer to the following table for how the Fax
Notification Email Address and Allow Fax Notification work

together.

Fax Notification
Email Address

field
If specified

Allow Fax Notification
Checked

* Notification will be sent to the
email address specified in the
Fax Notification Email
Address field.

The user will also be able to
enter an email address on the
Scan Station before scanning;
if an email address is entered,
a notification will be sent to
the address as well.

Allow Fax Notification
Unchecked

* Notification will be sent
to the email address
specified in the Fax
Notification Email
Address field.

If left blank

* The user will be able to enter
an email address on the Scan
Station before scanning; if an
email address is entered, a
notification will be sent to the
address.

« No notifications will be
sent.

NOTE: Fax/Printer notifications can only be configured after
destinations have been defined and at least one printer has
been defined. For information about setting up a printer see
the section entitled, “Setting up a printer destination” in
Chapter 7.
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8. Check Allow Custom Fax Numbers if you want the user to be able
to enter a fax number on the Scan Station.

9. Select the Maximum Port Speed supported by your fax connection.
10.Check Wait for Dial tone before dialing if required.

11. When you have finished entering information on this screen, click
Next. The following screen will be displayed. If you do not want to
allow the Scan Station to receive faxes, click No.

( KODAK Scan Station 700 Series - Scanner Admini i —h

Device Settings

Will the Scan Station be used for receiving faxes?

!Yes

@ No

Cancel | Previous ‘ Finish ‘
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Receiving faxes at the Scan

Station 730EX

. If you want your Scan Station 730EX to receive faxes?, click Yes in

the screen above, and then select Next. You will be able to enter
settings for incoming faxes.

,

Device Settings

Will the Scan Station be used for receiving faxes?

Incoming Fax configuration

Network Folder:

Email Address:

Printer:

[Nnne 'l

FTP:
[NDI’]E 'l

[C] Save as POF

I Cancel | [ Previous | Finish |

. Enter the required information in the Incoming Fax Configuration

fields. Enter one or more of the following destinations:

 a fully qualified path name to the Network folder where the
incoming fax will be saved.

» the Email address of the person/group where the incoming fax
will be delivered.

+ the Printer name where the incoming fax will be sent for printing.
» the FTP site where the incoming fax will be saved.
NOTES:

» If you configure the Scan Station to receive incoming faxes, you
must define at least one of the above destinations; otherwise the
faxes will not be delivered.

* In order for faxes to be routed to a printer, network folder or FTP
site, these destinations must be created in advance before they
may be selected.

3. Check Save as PDF if the incoming fax will be saved as a PDF file.
. Click Finish.

1.Available only for Scan Station 730EX units with a serial number
earlier than 52190000.

A-61796 June 2017

47



48 A-61796 June 2017




Chapter 5 Define Scan Settings

To define scan
settings

Scan Settings provide basic image processing settings, such as, color/
grayscale/black and white, output file format, compression, and some
advanced options like Hole Fill, Streak Filter, etc.

1. Select Edit>Scan Settings.

Edit | Scanner Help

Device Settings...

| Scan Settings...

Index Templates...
Destinations...
Groups...

lobs...

The Setup Scan Settings screen will be displayed.

Setup Scan Settings -l

(o) (2] ]

7 Black and White Multi-page TIFF
7 Black and White PDF
7 Black and White RTF
Black and White Single-page TIFF
Color JPEG
2 Color PDF
@ Defaults
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2. Click the Add #| icon. The following screen will be displayed.
[ & ¥0DAK Scan Station 700 Series-

Scan Settings

# | Scan Settings

Scan As: [E\ackand White 'I
File Type: [PDF 'I
Input Document: [Two Sided 'l
Resolution (DPI): [300 'l
Document Type: [Text with Graphics 'l
Cropping: [Autnmat\'c 'l
Post Scan Rotation: [Autnmat\'c 'l
» ) Black and White Settings

Compression: [Gruup 4 'I
Conversion Quality: [Eest (iThresholding) 'I
Contrast: ‘ 50 %

Maoise Filters: [Nnne vl
Image Filters: [Nme 'l

3. Make selections from any of the categories (e.g., Black and White
Settings, Advanced Settings, etc.).

NOTE: For a detailed description about the options, see the
sections that follow.

4. When finished making selections, click Next.

Scan Settings

Scan Settings Name:

My Scan Settings

) o)

5. Enter a name in the Scan Settings Name field that describes this
scan setting.

6. Click Finish.
7. Click Finish.
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Scan Settings Scan Settings

| Scan Settings

Scan As: |.B|acx and White = |
File Type [poF -
Input Document: |.Two Sided ! |
Resolution (DPI): |.30'D - |
Document Type: |.Text with Graphics - |
Cropping: |.Aut0matic = |
Paost Scan Rotation: |.Aut0matic A |

Scan As — select how you want documents to be scanned. Selections
are: Color, Grayscale, Black and White.

File Type — select one of the following options:

JPEG: this option is only available for Color or Grayscale. If your
Scan As selection is Black and White and JPEG is selected, your
Scan As selection will automatically change to Color.

TIFF - Single Page: creates multiple files, one for each side of a
scanned page.

TIFF - Multi Page: creates one file that contains all of the scanned
pages.

NOTE: The compression setting depends on the Scan As selection.
If the Scan As selection is Black and White, select a
compression setting from the Black and White Settings. If the
Scan As selection is Color or Grayscale, select a
compression setting from the Color Settings.

PDF: creates a PDF document. See “PDF Settings” on page 61 for
more information.
DOC: creates a Microsoft Word document.

RTF: creates a Rich Text Format file which can be read by a number
of applications.

XLS: creates a Microsoft Excel spreadsheet.

NOTES:

When scanning to DOC, RTF and XLS, optical character recognition
is performed on the scanned image. The .doc, .rtf or .xIs file produced
is based on the OCR results; therefore, the result may not be
identical to the original.

When you select DOC, RTF or XLS, the Language option will be
displayed. Select the language you want used to generate the file.
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Black and White

Input Type — select one of the following options:

* Two Sided: the Scan Station will scan the front and back in a single
pass.

* One-Sided - Face Down: if you select this option, the documents
must be put in the input tray face down (the side you want to scan
facing the input tray).

* One-Sided - Face Up: if you select this option, the documents must
be put in the input tray face up (the side you want to scan facing
toward you).

Resolution (DPI) — select 100, 150, 200, 240, 300, 400 or 600 dpi.

Higher resolutions produce better quality images, but larger file sizes.

NOTE: If the Document Type is PDF, this resolution setting is ignored
because the PDF resolution setting is used.

Document Type — select one of the following options:

» Text with Graphics: the documents contain a mix of text, business
graphics (bar graphs, pie charts, etc.) and line art.

+ Text: the documents contain mostly text.

* Photographs: the documents contain mostly photographs.

Cropping — select one of the following options:

+ Automatic: automatically detects the border of an image and
straightens it if necessary.

+ Aggressive: automatically detects the border of an image,
straightens it if necessary, and eliminates any residual black border
on any image edges. In order to achieve this, there is a possibility
that a small amount of image data from the edge of the document
may be lost.

Post Scan Rotation — select None or Automatic. If you select

Automatic, the Scan Station will analyze each document to determine
how it was fed and rotate the image to the proper orientation.

The Black and White settings will be grayed out, if your Scan As

Settings selection is Color or Grayscale.
» | Black and White Settings
Compression: |Group4 "|
Conversion Quality: | Best (iThresholding) - |
Contrast: 50 %
Meoise Filters: |NDne "|
Image Filters: |NDne "|
Compression — you can select None or Group 4.
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Color Settings

Conversion Quality —allows you to select Best (iThresholding) or
Normal (ATP).

» Best (iThresholding) — the Scan Station dynamically evaluates
each document to determine the optimal threshold value to produce
the highest quality image. This allows scanning of mixed document
sets with varying quality (such as faint text, shaded backgrounds, or
color backgrounds) to be scanned using a single setting thus
reducing the need for document sorting. When Best is selected, only
Contrast can be adjusted.

* Normal (ATP) (Adaptive Threshold Processing) — separates the
foreground information in an image (e.g., text, graphics, lines, etc.)
from the background information (i.e., white or non-white paper
background). When Normal is selected, you can adjust both
Threshold and Contrast.

Contrast — adjusts the amount of the image foreground which is kept
or attenuated. Decreasing this setting will reduce the amount of noise at
the expense of possibly losing faint text. Increasing this setting will help
make faint text more visible at the expense of creating more noise.

Threshold — aids in controlling the level at which a pixel is considered
black or white. Decreasing this setting will make the image appear
lighter, and can be used to subdue background noise. Increasing this
setting will make the image appear darker, and can be used to help pick
up light information. This options range from 0 to 255.

Noise Filters — select one of the following options:

* Lone Pixel: reduces random noise by converting a single black pixel
to white when it is completely surrounded by white pixels or by
converting a single white pixel to black when it is completely
surrounded by black pixels.

+ Majority Rule: sets each pixel based on its surrounding pixels. The
pixel will become white if the majority of the surrounding pixels are
white and vice versa.

Image Filters — you can select None or Halftone Removal. Halftone
Removal enhances dot matrix text and images with halftone screens
(e.g., newspaper photographs).

A | Coler Settings

Compression: |-JPEG = |

Cuality |-Gc:-or:| = |
Brightness and Contrast: |-Autc|matic = |
Color Balance: |-Autc|matic = |
Sharpen: | MNone = |
Background Smoothing: |-|"-lone "|
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Compression — select JPEG, None or LZW. JPEG creates multiple
files, one for the front and back of a page. If JPEG is selected, you can
select a Quality option of: Draft, Good, Better, Best or Superior.

NOTE: LZW is only available if TIFF: Single Page or TIFF Multi Page
is selected for the File Type.

Quality — allows you to select a Draft, Good, Better, Best or
Superior quality option. When saving a file as PDF, predefined
resolution settings will be used when selecting Good (150 dpi), Better
(200 dpi), and Best (300 dpi). The Scan Station dpi settings will not be
used when scanning in PDF mode.

NOTE: The quality settings impact the final size of the file (Draft
producing the smallest file size and Superior producing the
largest file size).

Brightness and Contrast — you can select None, Automatic or
Manual. If you select Automatic, the Scan Station will select the values
to use. If you select Manual, you can set specific values that will be
used for all images:

» Brightness: changes the amount of white in the color or grayscale
image. The values range from 1 to 100.

» Contrast: enhances or diminishes the differences between light and
dark pixels.

NOTE: If you are scanning documents with faint text added for security
and dark text that you want to keep for OCR, decrease this
setting.
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Color Balance — select one of the following options:
* None

» Automatic: adjusts the white background of each document to pure
white. This option compensates for the variations that occur between
different weights and brands of paper. This is not recommended for
use with photographs.

+ Automatic - Advanced: for advanced users that want to further
adjust the Automatic option.
- Aggressiveness: allows you to adjust the extent of the variation.
Increasing this value can help with documents that have yellowed
due to age. The values range from -2 to 2.

* Manual: allows you to set specific values that will be used for all
images:
- Red: changes the amount of red in the color image. The values
range from 1 to 100.

- Green: changes the amount of green in the color image. The
values range from 1 to 100.

- Blue: changes the amount of blue in the color image. The values
range from 1 to 100.

NOTE: Color Balance is not available for grayscale images.

Sharpen — controls the enhancement of edges in the document.
Options include: None, Normal, High and Exaggerated.

Background Smoothing — using this option for documents or forms
with a background color will help produce images with a more uniform
background color. This option improves image quality and may reduce
file size.
* None
* Automatic: smooths up to three background colors.
+ Automatic - Advanced: for advanced users that want to further
adjust the Automatic option.
- Aggressiveness: allows you to adjust the extent to which the
background(s) are determined. The values range from -10 to 10.
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Advanced Settings

# | Advanced Settings

Hale Fill:

Blank Image Detection: | None - ‘
Image Edge Fill: |.|'\.Ione - ‘
Streak Filter:

Color Cropout: None

Combine Front and Back Images: ||'\.|c-ne

Auto Color Detection: | MNone v ‘

Multifeed Ultrasonic Detection:

Maximum Document Length (in): | 14

Reverse Page Order

Hole Fill: allows you to fill in the holes that are around the edges of
your document. The types of holes that are filled include: round,
rectangular, and irregularly shaped (e.g., double-punched or those
having a slight tear that could have occurred when the document was
removed from a binder).

Blank Image Detection: used to detect blank pages (e.g., the back
side of a document), so these pages can be discarded. If you select this
option, you can select Based on Document Content where you can
select an aggressiveness value where document images that fall below
the value will be discarded.

Image Edge Fill: fills the edges of the final electronic image by
covering the area with the selected color.

* None

* Automatic: the scanner will automatically fill the edges of the image
using the surrounding color.

* Automatic - include tears: in addition to filling the edges, the Scan
Station will also fill in tears along the edge of document.

» White: allows you to enter values for the Top, Bottom, Left and Right
margins.

» Black: allows you to enter values for the Top, Bottom, Left and Right
margins.

Streak Filter: allows you to configure the Scan Station to filter vertical
streaks from your images. Streaks are lines which may appear on an
image and are not part of the original document. Streaks may be
caused by contaminants on your documents (e.g., dirt, dust or frayed
edges) or by not following the recommended cleaning procedures for
your Scan Station. Click Streak Filter to turn this option on where you
can select an Aggressiveness value which allows you to adjust the
extent at which the streaks are filtered. The values range from -2 to 2.
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Color Dropout — used to eliminate a form's background so that only
the entered data is included in the electronic image (e.g., remove the
form’s lines and boxes). For black and white images, these settings
affect the grayscale version of the document which the Scan Station
analyzes to produce that electronic image. This option is only
applicable for grayscale and black and white images. Select one of the
following options:

* None

* Multiple: drops colors other than dark shades (e.g., black or dark
blue ink)

* Predominant: drops the predominant color
* Blue

* Green

* Red

NOTE: When you select Multiple or Predominant, you can adjust
the Aggressiveness value to the extent at which colors are
dropped. The values range from -2 to 2. The default is 0.

Combine Front and Back Images — typically one image is created for

a document the front side and another image is created for the back

side. Turn this option on if you want one image that contains both the

front side and back side of the document. Select one of the following

options:

* None

* Front on Top: front side will be above the back side within the image.

* Front on Bottom: back side will be above the front side within the
image.

* Front on Left: front side will be to the left of the back side within the
image.

* Front on Right: back side will be to the left of the front side within the
image.
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Auto Color Detection — the scanner can detect color pages and
automatically save a color (or grayscale) image instead of black and
white, for just the color pages.

* Low: image/page requires only a small amount of color to be saved
as color/grayscale, e.g. primarily black text with small logos.

* Medium: image/page requires more color, as compared with the Low
option, before being saved as color/grayscale.

» High: image/page requires more color, as compared with the Medium
option, before being saved as color/grayscale. Used for
distinguishing images containing medium- to large-size colorful
photos from plain black text. Photos with neutral colors may require
adjustments to the Color Threshold or Color Amount values in order
to be captured correctly.

» Custom: allows you to manually adjust the Color amount and/or
Color threshold.

- Color amount — the amount of color that needs to be presentin a
page before it will be saved as either color/grayscale. As the value
of Color Amount increases, more color pixels are required. Valid
values are 1 to 200.

- Color threshold — the color threshold or saturation (i.e., pale blue
vs. dark blue) at which a given color will be included in the color
amount calculation. A higher value indicates that a more intense
color is required. Valid values are 0 to 100.

NOTE: When setting Auto Color Detection values, it is suggested
that you start with the Medium option and scan a typical job
set. If too many images were returned as color/grayscale vs.
black and white, then change to the High option and re-run
the job. If too few images were returned as color/grayscale
vs. black and white, then change to the Low option and re-
run the job. If none of these options provide the desired
result, select Custom to manually adjust Color Amount and/
or Color Threshold.
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Multifeed Ultrasonic Detection — multifeed detection aids in
document processing by detecting documents that may go through the
feeder overlapped. Multifeeds can happen due to stapled documents,
adhesives on documents, or electrostatically charged documents.
Check this option if you want to enable a Multifeed Response when a
multifeed is detected.

* Multifeed Sensitivity — controls how aggressively the scanner will
work to determine if more than one document is fed into the scanner.
Multifeeds are triggered by detecting air gaps between documents.
This allows multifeed detection to be used with job sets containing
documents with mixed thicknesses.

- Low: least aggressive setting and is less likely to detect labels,
poor quality, thick or wrinkled documents as multi-fed documents.

- Medium: use if your job set has varying document thicknesses or
labels attached to the document. Depending on the label material,
most documents with labels should not be detected as a multi-fed
document.

- High: the most aggressive setting. This is a good setting to use if
all documents have a thickness no greater than 20-Ib. bond paper.

NOTE: Regardless of the setting, “sticky” notes may still be detected
as multi-fed documents.

* Multifeed Response — select what action you want the Scan
Station to take when a multifeed is detected. With all options, the
condition will be logged in the Scan Station.

- Continue Scanning: the Scan Station will continue to scan.

- Stop Scanning: scanning will stop and you will have to option to
continue scanning or cancel the batch. Verify that the paper path
has been cleared and restart the scan session from the scanning
application.

Maximum Document Length (in.) — allows you to select the
maximum length of the documents in your job. If the Scan Station
detects a document longer than this value, it will determine that a paper
jam has occurred. The default is 14 inches. Maximum length is 160
inches; minimum length is 2.5 inches.

Reverse Page Order — if enabled, the Scan Station will reverse the
order of the scanned images from the order in which the documents
were scanned.

Allow Adding Pages To Scan Job — when enabled, the user can
continue to add pages to a scan job. After all pages in the input tray
have been scanned, a message will be displayed asking if they want to
add more pages. If the user selects Yes, the additional pages will be
scanned and the message will be displayed again until the user selects
No, or the 30-second timeout has occurred.
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Barcode Type — select a barcode type.

Allow Adding Pages To Scan Job:

Barcode Type: Code 3of 0
CODABAR
Interleaved 2 of 5
Code 128

UPC-A M

Barcodes are read anywhere on the front and back of a document. The
read order is left to right, top to bottom in both horizontal and vertical
orientations. A maximum of 10 barcodes are read on each side of a
document.

NOTES:

« Barcode accuracy is highly dependent on the quality of the scanned
image. Higher resolution and larger barcodes will increase accuracy.
Recommended scanner settings are 300 dpi, black and white or
grayscale. If your output type is PDF, the Best quality setting should
be used. Image compression may also affect accuracy. Choose the
minimum compression, or uncompressed, to increase read accuracy.

+ If you define an Index Template, the values set in the index template
will override any options selected here. See “Chapter 6 Index
Templates” on page 65 for more information.

Select the barcode type(s) from the Barcode Type list that match the
barcodes on the documents to be scanned. Barcode data read when a
document is scanned will be saved as metadata to a corresponding
xml file. A .xsd file has been provided on the Installation CD to validate
the metadata file for integration into your back-end system.

NOTE: You must check Enable output metadata in Device Settings to
create the output metadata file.

Available barcode types are:

* Code 3 0of9

+ CODABAR

* Interleaved 2 of 5
* Code 128

* UPC-A

* UPC-E

« EANS8

+ EAN 13

+ PDF-417

NOTE: Selection of multiple barcode types may affect throughput
performance.
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PDF Settings

# | PDF Settings

Quality: Good =
Searchable:

Single Pages:

Secure:

Compatibility: | PDF v1.6 -

Quality — allows you to select a Good, Better or Best quality option.
When saving a file as PDF, predefined resolution settings will be used
when selecting Good (150 dpi), Better (200 dpi), and Best (300 dpi).
The Scan Station dpi settings will not be used when scanning in PDF
mode.

Searchable — creates a single- or multi-page document that contains
both text and image data. OCR (Optical Character Recognition)
technology is used to extract text information from the scanned image
data. When you select this option, the Language option is displayed.
Select the language you want used to generate the PDF file.

NOTE: This option specifically turns on OCR. OCR can also be enabled
by selecting XLS, DOC and RTF output.

Single Pages — creates a PDF file for every page scanned. If
scanning a two-sided document, a separate file will be created for both
the front and back page.

Secure — allows the user to enter a password that will be used to
encrypt the file before the file is delivered. The password will be sent in
a separate email when Email is one of the destination selections.

Compatibility — this option is specialized for the digital preservation of
electronic documents and is used if you want to generate a PDF that
will be used for long term needs. Select the desired PDF option from
the drop-down list.

NOTE: PDF/A and Secure are mutually exclusive.
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Filename Settings

# | File Mame Settings

Device Name 'H + || LI |
Text 1

Text 2

Date

Text 3

Time (hhmmssff)

Text 4

Sequence Number

KS5700

LAKS5700_20131203_13392693_1.pdf

File Name Settings allow you to define values that determine the
locations (directories or subdirectories) and file name used when
creating scanned documents. You might want to:

* Define a folder name where scanned documents will be placed when
scanning to a network folder, FTP location or USB drive destination.

» Define a file name prefix that will be applied to every scanned
document created. Scanned documents are created with this prefix.

* Allow user input of other text to include in the file name, based on the
specific documents being scanned.

* Include a date and time stamp in the file name.

For example, if you define a prefix of receipts with a date and time
stamp, and a folder name of 2072, the scanned document file name will
have the format: receipts 20120117 _092219.tif and is placed in a
folder called 2012

* Device Name — allows you to use the Scan Station name in the file
name or as part of the file path.

* User Name — the user name of the person logged into the Scan
Station. If Force User login is disabled (not required to login to the
Scan Station), the User name will be blank.

+ Job Name — the title that is displayed on the Job button selected
when using the Jobs screen. If working with the walk-up Scan
Station, the Job name will be blank. This is not a valid selection if you
have not defined a job. For more information see “Chapter 9 Create
Jobs” on page 109.

» Date — allows you to enter the date in the file name or as part of the
file path.

+ Time (hhmmssff) — allows you to add the time (hhmmssff) in the file
name or as part of the file path.

» Sequence Number — allows you to use a sequence number in the
file name or as part of the file path.

» Text — allows you to type in text that will be used in the file name or
as part of the file path. This is limited to the maximum characters
allowed by the target operating system.
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» User Input — causes the Scan Station to prompt for file name input
when a user scans with this job; the value entered by the user
becomes part of the file name.

» Directory Separator — allows you to use a separator in the file
name or as part of the file path.

NOTES:
* Use the up and down arrows to reorder the items in the boxes.

* When entering values, the sample file name will be displayed in the
text box at the bottom of the screen.

* When you select Text, Date or Sequence Number additional
selections will be displayed on the right.

* At least one entry must always be in the File Name field.

* If you defined an Index Template, the values set in the index template
will override any options selected here. For more information, see
“Chapter 6 Index Templates” on page 65.
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Chapter 6 Index Templates

This chapter provides procedures for using the Index Template to
define barcode and OCR regions and then use them to create a path
and file name.

An index template is used to define index fields on a document to be
scanned. The index fields contain information that can be used to
classify, sort, or store the scanned documents in a particular order
(referred to as indexing). The index fields will either be one or more
barcodes and/or one or more areas of text (OCR data). The index
template also allows you to specify how to use the index field from a
defined region in a file name or directory path.

An index template allows you to specify where the barcode and OCR is
on the document and where to use the information when creating the
path and file name for the scanned document.

Index templates are used in conjunction with Jobs (see “Chapter 9
Create Jobs” on page 109 for more information). A Job will be set up to
process each type of form along with any documents related to that
form. For example, one job may be setup to process an insurance form,
another job may be setup to process an invoice form, etc. An index
template would be defined for each unique type of document (form) and
then associated with the job configured to scan and process that form.

Each index template is associated with one form.
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Creating an index The steps below describe how to set up an index template. See the

template sections that follow for field and icon descriptions on each of the Index
Template screens. There are two Index Template Settings screens: one
Edit | Scanner  Help screen is where you add, edit and delete index templates; the other
Device Settings... screen is where you define the name of the index template.
Scan Seftings.. 1. Scan a representative document for each type of unique document

| IndexTemplates., | (form) that you want to define a barcode or OCR index.

Destinations...

2. Select Edit>Index Templates. The Setup Index Templates screen
will be displayed. If index templates have already been defined, they
will be listed on this screen, otherwise the screen will be blank.

Groups...

Jobs...

3. Click the Add icon ﬂ . The Index Template Settings screen will be
displayed.

4. Select the Index Field Editor icon |§| to create a barcode and/or
OCR index fields The Index Field Editor screen will be displayed.

5. Click the Open Image icon s . The Select Image dialog box will
be displayed.

6. Select one of the scanned documents you scanned in Step 1 that
you want to apply an barcode/OCR region to. When the image is
selected, it will be displayed in the image window on the Index Field
Editor screen.

7. Determine if you want to create a barcode or OCR region.

+ If you want to define a OCR region, click the OCR icon %% |
+ If you want to define a barcode region, click the Barcode
icon I

When the icon is clicked, a cross hair is displayed. Move the cross
hair to the area you want to select, click and hold the left mouse
button, drag the cross hair across the part of the image you want and
release the button. Depending on your selection the Barcode (or
OCR) Field Properties screen will be displayed.

NOTES:

» If you want to change the location of the index field, click inside
the field and drag it to a new location.

+ If you need to change the size of an index field, click one of the
red handles and drag it to adjust the size.

- 564 326 987 8 -
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+ If an index field is selected, the Barcode and OCR icons will be
disabled. Click anywhere outside of an index field to enable these
icons.

]
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8. Define the barcode or OCR region on the Barcode Field Properties
screen or the OCR Field Properties screen and click Done. The
Index Field Editor screen will be redisplayed with the index(es) and
index field properties you set up. Click OK. The Index Template
Settings screen will be displayed.

9. Define your File Name Settings by selecting the values from the
drop-down list and click Next.

~) File Name Settings

Device Name o (#)(] _—
kLl ot 1

Text2 KSS700

b

.\K55700_20131203_13392693_1.pdf

10.When the Index Template Setting screen is displayed, enter the
desired template name in the Index Template Name field and click
Finish to return to the Setup Index Templates screen. The index
template you created will be displayed.
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Setup Index The Setup Index Templates screen displays any index templates that
Templates screen have been previously defined and allows you to add, edit and delete
index templates.

Setup Index Templates

(o) () ()

Credit Form
Account Statement

Icon Description

il Displays the Index Template Settings screen, which allows you
to add an index template.

x Allows you to view or edit the selected index template.

1 | Allows you to delete the selected index template.

Index Template list — displays the index templates that have been
created.

Cancel — closes the Setup Index Templates screen and returns you to
the Kodak Scan Station 700 Series - Scanner Administration main
screen.

Previous, Next, Finish — not available on this screen.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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Index Template The Index Template Settings screen allows you to create and maintain
Settings screen index fields.

& KODAK Scan Station 700 Series - Scanner Administration |m22m|

Index Template Settings >-

A Index Settings

Index (&)

| Page Count Separation

Enable Page Count Separation:

Page Count: 2 %
~ File Name Settings
(]

Text 1

Text 1

Text 2

Date

Text 3 A

Time (hhmmssf) Maximunm Length: | 1 %

Text4 (v

Sequence Number

KS5700

Cancel ‘ Next ‘

Index Settings

Icon Description

i Index Field Editor icon displays the Index Field Editor screen
E| where you can create a barcode or OCR index field(s) for your
index template.

LI Allows you to delete the selected index field.

x Allows you to view or edit the selected index field.

* Index box — displays the index fields that have been created for your
index template.

* Page Count Separation — allows you to separate documents based
on number of pages. If page count separation is enabled then
separation based on a barcode cannot be enabled.
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File Name Settings

Icon Description

Allows you to add the file name value that is currently displayed
il or selected in the File Name Settings drop-down list to your file
name path. Any indexes that you have defined will also be
displayed in the list.

'l_l Allows you to delete the selected index field.

File Name Settings field — allows you to define values that determine
the locations (directories or subdirectories) and file name used when
creating scanned documents. You can define a folder name where
scanned documents will be placed when scanning to a network folder,
FTP location or USB drive destination. Click the down arrow to display
a list of values that you can add to your file name path. You must make
at least one entry in this field.

# | File Mame Settings

®

Device Name
Uzer Mame
Job Mame
Date

Time (hhmmssf) e
Page =
Sequence Number |1|
Text

Directory Separatar ()
Sue

AKSST00 20151111 13353182 001.ext
* Device Name — uses the Scan Station name in the file name or part
of the file path.

» User Name — uses the logged-in user name in the file name or part
of the file path.

» Job Name — uses the job name in the file name or part of the file
path.

+ Date — allows you to enter the date in the file name or part of the file
path.

* Time (hhmmssff) — adds the time (hhmmssff) in the file name or
part of the file path.

» Page — uses a page number in the file name or part of the file path.

* Sequence Number — uses a sequence number in the file name or
part of the file path.
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* Text — allows you to enter any text that will be used in the file name
or as part of the file path. This is limited to the maximum characters
allowed by the target operating system.

* User Input — causes the Scan Station to prompt for file name input
when a user scans with this job; the value entered by the user
becomes part of the file name.

» Directory Separator — uses a separator as part of the file path.

* Indexes — these are the names that you defined when you
configured your barcode and/or OCR regions which you can use in
the file name or as part of the file path.

NOTES:
» Use the up and down arrows to reorder the items in the boxes.

* When entering values, the sample file name will be displayed in
the text box at the bottom of the screen.

* When you select Text, Date or Sequence Number additional
selections will be displayed on the right.

Text 1

Suel

Maximum Length: 16 %

* At runtime, invalid file name characters will be replaced by a “?”.

» At runtime, file names cannot exceed 256 characters in length.

Cancel — closes the Index Template Settings screen and returns you
to the Setup Index Templates screen.

Next — goes to the next Index Template Settings screen where you
can enter a name for this index template.

Finish — saves your selections and returns to the Setup Index
Templates screen.

NOTE: If you are setting up a new index template, Finish will not be
available, you must click Next to name your index template.
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Index Template The Index Template Settings (name) screen will be redisplayed after
settings (name) you configure your index template values where you will enter an Index
Template name.

r — ~
£ KODAK Scan Station 700 Series - Scanner Administration “ [
Index Template Settings —

Index Template Name:

screen

My Index Template‘

I I Cancel | [ Previous | Finish |
kL

Cancel and Finish — returns to the Index Setup Template screen.

Previous — returns to the previous screen.
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Index Field Editor
screen

Use this screen to create barcode and/or OCR index fields.

o5l Index Field Editor

.

Index
Wabilnmber ]
s A 0 iy [{ode

oo™ ALY My

| ()
Andevsom Grove

ek Number Raceivar's Company Name
Mark Anderson

235 Meain St

For The Anention Of

Street Address

City

MD o tréad Wuekre
w0 T3 -

0K Cancel
]

Country

de
12345

(aneado

Icons

Open Image: displays the Select Image dialog box where
™~ you can select a JPEG or TIFF image to apply an OCR and/
or barcode region to.
@ (9 r= Viewicons: selectthe Zoom In, Zoom Out or Actual 1:1 icon
NN o view the image at the desired viewing size.
Edit: displays the OCR Field Properties or Barcode Field

T Properties screen where you can make changes to the
selected index value.

¥ | Delete: deletes the selected index value.

Barcode: displays the Barcode Field Properties screen
L where you can set up the properties of a barcode index field.

Index: displays the OCR Field Properties screen where you

R can setup the properties of an OCR index field.

Index box — displays any index fields that you have defined for this
index template.

Viewer area — when an image is selected, it will be displayed in the
Viewer area of the Index Field Editor screen where you can select an
area to apply an OCR and/or barcode region to.

Properties box — displays the options that you selected on the
Barcode Field Properties and/or OCR Field Properties screen.

OK — saves your changes and returns to the Index Template Settings
screen.

Cancel — closes the Index Field Editor screen without saving any
changes.
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Barcode Field The Barcode Field Properties screen allows you to set up a barcode

Properties screen index field and this screen can be accessed by releasing the mouse
button after drawing the region around the desire barcode field or by
selecting the Edit icon on the Index Field Editor screen.

Barcode Field Properties v '

Field Name: | [ Verify Checksum

Diefault Value: | Minimum Length: lﬁi
Minimum Partial Length: ’Di

Type:
Confidence: ll}i
Orientation: ’W
Filtering: Mo Fitering -
Separation: Mone -
Quality:  Worst I Best

Done | Cancel |

* Field Name — the barcode field must have a name in order to save
it. This name identifies the barcode field and is displayed in:

- the Index list in the Index Field Editor.
- the Index list in the Index Template Settings screen.
- the File Name Settings drop-down list.

» Default Value — the value entered in this field will be used if the
barcode cannot be read or is missing.

» Type — lists the types of barcodes that are available. Only one
barcode type can be selected. The following barcode types are

supported:
Code 3 of 9 UPC-E
CODABAR EAN-8
Interleaved 2 of 5 EAN-13
Code 128 PDF-417
UPC-A

+ Verify Checksum — check this box if the barcode contains a
checksum character. Checksum characters help ensure the accuracy
of barcode reading. Not all barcode types support checksum
verification. Barcode types that optionally support checksum
verification include: Code 3 of 9, CODABAR and Interleaved 2 of 5.

Some barcode types such as, PDF-417, UPC and EAN have a built-
in checksum capability that cannot be disabled.

If Verify Checksum is not checked for barcodes containing a
checksum, the checksum value (usually the last character of the
barcode) will appear in the barcode value; otherwise, the check digit
will remain hidden.
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If checksum verification fails during scanning, a barcode value is not
generated. Some barcode types, such as Code 128, have mandatory
checksum characters. The code is always present and must be
correct for the value to be read. Other codes have optional checksum
characters which then add an additional character when present.

To read invalid Code 128 symbols, you can select the Minimum
Partial Length option. It will report the data characters even if
checksum fails. The invalid checksum will not be returned. When the
barcode has an optional checksum, it will not be validated by the
software.

Selecting Minimum Partial Length for a barcode with an optional
checksum will return what it finds, whether it is good or bad.
Occasionally, a barcode will return the correct result but the
checksum fails.

* Minimum Length — enter a minimum length of the barcode value in
this field. The default minimum length is 6. It is recommended that the
minimum length be set at 6 or less in order to retain barcode values
in cases of a partial reading.

* Minimum Partial Length — enter a value in this field if you want to
generate a barcode value, even if it is incomplete. This is useful for
barcodes that are only used for document separation where the
absolute value is less critical.

NOTE: Minimum Partial Length should not be used when Verify
Checksum is checked, as this may result in a barcode value
being generated when checksum verification fails.

+ Confidence — enter a number in this field to restrict what is
considered to be a successful barcode read. For example, the higher
the value that is entered, the chance of misreading barcodes will be
reduced. Confidence values range from 0 (any confidence) to 100
(absolute certainty).

» Orientation — specify the orientation of the barcodes in the
document. Selections are: Horizontal, Vertical and Horizontal and
Horizontal.

* Filtering — when reading barcodes from fax machines or other
devices that may have CCD pixel dropout, applying a filter may help
the read rate if bars are missing pixels. Selecting Filter1 will fill a gap
in a bar of 1 pixel. Filter2 will fill a gap of 2 pixels, etc.
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» Separation — allows you to use a barcode as an indicator to create
a new document. This document is referred to as a “separator
document”. Separation can only be selected for one index.

- None

- Create a new document — the separator document and all
following documents are separated into a new document.

- Delete Page — all documents following the separator document
are separated into a new document. The separator document is
deleted. This is important when the separator document is used for
the purpose of document separation and does not contain any
significant information. The barcode, however, is still available for
indexing. However, if Delete Page is enabled, and Enable output
metadata (Device Settings/Configuration Options) is also enabled,
the bar code from this deleted page will not show up in the xml file.

- Delete duplex page — deletes the separator document and the
following page when scanning two-sided documents. This is
important when a separator document is used for the purpose of
document separation and does not contain any significant
information. The barcode, however, is still available for indexing.
However, if Delete duplex page is enabled, and Enable output
metadata (Device Settings/Configuration Options) is also enabled,
the bar code from this deleted page will not show up in the xml file.

NOTE: Do not enable Blank Page Detection when using the
Delete duplex page option.

* Quality — If desired, select a quality setting between Worst and
Best. The highest quality barcodes are printed by a laser printer or
pre-printed with an offset printer. Lower quality barcodes are printed
with inkjet or dot-matrix technology. Depending on the quality of
barcodes being scanned, set the Quality level accordingly. The
higher the quality setting, the faster the barcode read performance.

Done — saves your barcode index fields and returns to the Index
Template Settings screen.

Cancel — closes the Barcode Field Properties screen and returns you
to the Index Template Settings screen without saving your changes.
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OCR Field Properties The OCR Field Properties screen allows you to set up an OCR index

screen field. This screen can be accessed by releasing the mouse button after
drawing the region around the desire OCR field or by selecting the Edit
icon on the Index Field Editor screen.

OCR Field Properties

Field Name: [Waybill Name Default Value: |DHL

Language: |Eng\ish j

Done | Cancel |

* Field Name — enter the name of the OCR field. The OCR field must
have a name in order to save it. This name identifies the OCR field
and is displayed in:

» the Index list in the Index Field Editor.
» the Index list in the Index Template Settings screen.
» the File Name Settings drop-down list.

« Default Value — the value entered in this field will be used if the
OCR index field cannot be read or is missing.

» Language — select the appropriate language from the drop-down
list to ensure that special language-specific characters (e.g., ¢ or ()
will be recognized.

Done — saves your OCR index values and returns to the Index
Template Settings screen.

Cancel — closes the OCR Field Properties screen and returns you to
the Index Template Settings screen without saving your changes.
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Use cases Following are some use cases where barcode detection can be useful.
There could be many variations on these cases but these should be
helpful in understanding how Scan Station uses barcode detection.

Car dealership

A car dealership has 20 locations and a key part of its business
depends on processing car loan applications. The customer is usually
waiting in the lobby for the approval. A car loan application is done on a
standard paper form which contains a unique barcode. Supporting
documentation such as a copy of a driver's license, taxes, proof of
income or residence can also be provided.

Problem

The salesperson fills out the application with the customer and faxes it
to the corporate office. The salesperson calls the corporate office to be
sure it arrived and is being processed. The image quality of the fax is
frequently poor and rescans are common because settings are not pre-
set. Therefore, the salesperson spends their time trying to keep the
customer from leaving the dealership and calling the corporate office to
determine a decision on the loan.

Solution

Using a Scan Station a Car Loan job is configured to have the correct
scan settings and destination. The salesperson walks up to the Scan
Station with the loan application and supporting documentation, scans
the document(s) in the correct order and selects the preconfigured Car
Loan button. The job is setup to scan a region of interest on the image
for a barcode. The barcode is scanned and the value is used to
uniquely name the file (Car Loan